Cisco Customer Voice Portal (CVP)
Installation Guide
Customer Voice Portal (CVP) Release 3.0(0)
January 2005

Corporate Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000
800 553-NETS (6387)
Fax: 408 526-4100

THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT
NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT
ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR
THEIR APPLICATION OF ANY PRODUCTS.
THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION
PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO
LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.
The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as
part of UCB’s public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.
NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE
PROVIDED “AS IS” WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED
OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.
IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL
DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR
INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.
CCSP, the Cisco Square Bridge logo, Follow Me Browsing, and StackWise are trademarks of Cisco Systems, Inc.; Changing the Way We Work,
Live, Play, and Learn, and iQuick Study are service marks of Cisco Systems, Inc.; and Access Registrar, Aironet, ASIST, BPX, Catalyst, CCDA,
CCDP, CCIE, CCIP, CCNA, CCNP, Cisco, the Cisco Certified Internetwork Expert logo, Cisco IOS, Cisco Press, Cisco Systems, Cisco Systems
Capital, the Cisco Systems logo, Cisco Unity, Empowering the Internet Generation, Enterprise/Solver, EtherChannel, EtherFast, EtherSwitch, Fast
Step, FormShare, GigaDrive, GigaStack, HomeLink, Internet Quotient, IOS, IP/TV, iQ Expertise, the iQ logo, iQ Net Readiness Scorecard,
LightStream, Linksys, MeetingPlace, MGX, the Networkers logo, Networking Academy, Network Registrar, Packet, PIX, Post-Routing,
Pre-Routing, ProConnect, RateMUX, ScriptShare, SlideCast, SMARTnet, StrataView Plus, SwitchProbe, TeleRouter, The Fastest Way to Increase
Your Internet Quotient, TransPath, and VCO are registered trademarks of Cisco Systems, Inc. and/or its affiliates in the United States and certain
other countries.
All other trademarks mentioned in this document or Website are the property of their respective owners. The use of the word partner does not imply
a partnership relationship between Cisco and any other company. (0501R)
CiscoCustomer Voice Portal (CVP ) Installation Guide
Copyright © 2001–2005, Cisco Systems, Inc.
All rights reserved.

CONTENTS
About This Guide
Purpose

v

v

Audience

v

Organization

v

Conventions

vi

Other Publications

vi

Obtaining Documentation vi
Cisco.com vi
Documentation CD-ROM vii
Ordering Documentation vii
Documentation Feedback vii
Obtaining Technical Assistance viii
Cisco.com viii
Network Professional Connection viii
Technical Assistance Center viii
Cisco TAC Website ix
Cisco TAC Escalation Center ix
Obtaining Additional Publications and Information

CHAPTER

1

Installation Overview

ix

1-1

Introduction to CVP installation 1-1
What is Included in CVP installation? 1-1
What is not Included in CVP Installation? 1-4
Before Installing CVP Software

CHAPTER

2

Installing CVP Software

1-4

2-1

CVP Installation and Configuration Procedures
Application Server Configuration 2-8
Voice Browser Configuration 2-12

2-1

Installing the CVP VoiceXML Server Software

2-14

After you Install CVP Software 2-14
Setting up Gateways/Gatekeepers to Interact with CVP 2-14
A further note on copying files to the Gateway/Gatekeeper

2-15

Cisco Customer Voice Portal (CVP) Release 3.0 (0) Installation Guide

iii

Contents

Updating Cisco NAM/ICM Components to Support SDDSN 2-16
Setting up Cisco NAM/ICM Software to Interact with CVP 2-17
Upgrading CVP Software

2-17

Uninstalling CVP Components
CVP Security

2-20

2-22

Activating the Security Feature 2-22
Current Limitations of the CVP Security Feature
Troubleshooting CVP Install / Upgrade / Uninstall
INDEX

Cisco Customer Voice Portal (CVP) Release 3.0 (0) Installation Guide

iv

2-23
2-24

About This Guide
Purpose
This manual describes how to install and configure the Cisco Customer Voice Portal (CVP) components.

Note

Previous releases of the Cisco Customer Voice Portal product were branded as the Internet Service Node
(ISN). Some references to ISN remain in the product software and in the documentation.

Audience
This manual is intended for anyone installing CVP software.

Organization
The manual is divided into the following chapters.
Chapter

Description

Chapter 1, “Installation
Overview”

Provides an introduction to the installation
procedure.

Chapter 2, “Installing
CVP Software”

Provides instructions for installing and setting up
CVP software.
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Conventions

Conventions
This manual uses the following conventions:
Format

Example

Boldface type is used for user
Choose Script > Call Type Manager.
entries, keys, buttons, and folder
and submenu names.
Italic type indicates one of the
following:
•

A newly introduced term

•

For emphasis

•

A generic syntax item that
you must replace with a
specific value

•

A title of a publication

An arrow (>) indicates an item
from a pull-down menu.

•

A skill group is a collection of agents
who share similar skills.

•

Do not use the numerical naming
convention that is used in the
predefined templates (for example,
persvc01).

•

IF (condition, true-value,
false-value)

•

For more information, see the Cisco
ICM Software Database Schema
Handbook.

The Save command from the File menu is
referenced as File > Save.

Other Publications
For additional information about Cisco Customer Voice Portal (CVP) software, see the Cisco web site
listing CVP documentation.

Obtaining Documentation
Cisco provides several ways to obtain documentation, technical assistance, and other technical
resources. These sections explain how to obtain technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation on the World Wide Web at this URL:
http://www.cisco.com/univercd/home/home.htm
You can access the Cisco website at this URL:
http://www.cisco.com
International Cisco web sites can be accessed from this URL:
http://www.cisco.com/public/countries_languages.shtml
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Documentation CD-ROM
Cisco documentation and additional literature are available in a Cisco Documentation CD-ROM
package, which may have shipped with your product. The Documentation CD-ROM is updated monthly
and may be more current than printed documentation. The CD-ROM package is available as a single unit
or through an annual subscription.
Registered Cisco.com users can order the Documentation CD-ROM (product number
DOC-CONDOCCD=) through the online Subscription Store:
http://www.cisco.com/go/subscription

Ordering Documentation
You can find instructions for ordering documentation at this URL:
http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm
You can order Cisco documentation in these ways:
•

Registered Cisco.com users (Cisco direct customers) can order Cisco product documentation from
the Networking Products MarketPlace:
http://www.cisco.com/en/US/partner/ordering/index.shtml

•

Registered Cisco.com users can order the Documentation CD-ROM (Customer Order Number
DOC-CONDOCCD=) through the online Subscription Store:
http://www.cisco.com/go/subscription

•

Nonregistered Cisco.com users can order documentation through a local account representative by
calling Cisco Systems Corporate Headquarters (California, U.S.A.) at 408 526-7208 or, elsewhere
in North America, by calling 800 553-NETS (6387).

Documentation Feedback
You can submit comments electronically on Cisco.com. On the Cisco Documentation home page, click
Feedback at the top of the page.
You can e-mail your comments to bug-doc@cisco.com.
You can submit your comments by mail by using the response card behind the front cover of your
document or by writing to the following address:
Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883
We appreciate your comments.
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Obtaining Technical Assistance
Cisco provides Cisco.com, which includes the Cisco Technical Assistance Center (TAC) Website, as a
starting point for all technical assistance. Customers and partners can obtain online documentation,
troubleshooting tips, and sample configurations from the Cisco TAC website. Cisco.com registered users
have complete access to the technical support resources on the Cisco TAC website, including TAC tools
and utilities.

Cisco.com
Cisco.com offers a suite of interactive, networked services that let you access Cisco information,
networking solutions, services, programs, and resources at any time, from anywhere in the world.
Cisco.com provides a broad range of features and services to help you with these tasks:
•

Streamline business processes and improve productivity

•

Resolve technical issues with online support

•

Download and test software packages

•

Order Cisco learning materials and merchandise

•

Register for online skill assessment, training, and certification programs

To obtain customized information and service, you can self-register on Cisco.com at this URL:
http://www.cisco.com

Network Professional Connection
Cisco provides a forum where you can discuss and exchange information regarding call center issues.
To access the the forum, go to the following Web site:
http://www.cisco.com/discuss/contactcenter

Technical Assistance Center
The Cisco TAC is available to all customers who need technical assistance with a Cisco product,
technology, or solution. Two levels of support are available: the Cisco TAC website and the Cisco TAC
Escalation Center. The avenue of support that you choose depends on the priority of the problem and the
conditions stated in service contracts, when applicable.
We categorize Cisco TAC inquiries according to urgency:
•

Priority level 4 (P4)—You need information or assistance concerning Cisco product capabilities,
product installation, or basic product configuration.

•

Priority level 3 (P3)—Your network performance is degraded. Network functionality is noticeably
impaired, but most business operations continue.

•

Priority level 2 (P2)—Your production network is severely degraded, affecting significant aspects
of business operations. No workaround is available.

•

Priority level 1 (P1)—Your production network is down, and a critical impact to business operations
will occur if service is not restored quickly. No workaround is available.
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Cisco TAC Website
You can use the Cisco TAC website to resolve P3 and P4 issues yourself, saving both cost and time. The
site provides around-the-clock access to online tools, knowledge bases, and software. To access the
Cisco TAC website, go to this URL:
http://www.cisco.com/tac
All customers, partners, and resellers who have a valid Cisco service contract have complete access to
the technical support resources on the Cisco TAC website. Some services on the Cisco TAC website
require a Cisco.com login ID and password. If you have a valid service contract but do not have a login
ID or password, go to this URL to register:
http://tools.cisco.com/RPF/register/register.do
If you are a Cisco.com registered user, and you cannot resolve your technical issues by using the Cisco
TAC website, you can open a case online at this URL:
http://www.cisco.com/en/US/support/index.html
If you have Internet access, we recommend that you open P3 and P4 cases through the Cisco TAC
website so that you can describe the situation in your own words and attach any necessary files.

Cisco TAC Escalation Center
The Cisco TAC Escalation Center addresses priority level 1 or priority level 2 issues. These
classifications are assigned when severe network degradation significantly impacts business operations.
When you contact the TAC Escalation Center with a P1 or P2 problem, a Cisco TAC engineer
automatically opens a case.
To obtain a directory of toll-free Cisco TAC telephone numbers for your country, go to this URL:
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml
Before calling, please check with your network operations center to determine the level of Cisco support
services to which your company is entitled: for example, SMARTnet, SMARTnet Onsite, or Network
Supported Accounts (NSA). When you call the center, please have available your service agreement
number and your product serial number.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online
and printed sources.
•

The Cisco Product Catalog describes the networking products offered by Cisco Systems as well as
ordering and customer support services. Access the Cisco Product Catalog at this URL:
http://www.cisco.com/en/US/products/products_catalog_links_launch.html

•

Cisco Press publishes a wide range of networking publications. Cisco suggests these titles for new
and experienced users: Internetworking Terms and Acronyms Dictionary, Internetworking
Technology Handbook, Internetworking Troubleshooting Guide, and the Internetworking Design
Guide. For current Cisco Press titles and other information, go to Cisco Press online at this URL:
http://www.ciscopress.com

•

Packet magazine is the Cisco monthly periodical that provides industry professionals with the latest
information about the field of networking. You can access Packet magazine at this URL:
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http://www.cisco.com/en/US/about/ac123/ac114/about_cisco_packet_magazine.html
•

iQ Magazine is the Cisco monthly periodical that provides business leaders and decision makers
with the latest information about the networking industry. You can access iQ Magazine at this URL:
http://business.cisco.com/prod/tree.taf%3fasset_id=44699&public_view=true&kbns=1.html

•

Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering
professionals involved in the design, development, and operation of public and private internets and
intranets. You can access the Internet Protocol Journal at this URL:
http://www.cisco.com/en/US/about/ac123/ac147/about_cisco_the_internet_protocol_journal.html

•

Training—Cisco offers world-class networking training, with current offerings in network training
listed at this URL:
http://www.cisco.com/en/US/learning/le31/learning_recommended_training_list.html
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C H A P T E R

1

Installation Overview
This chapter provides:

Note

•

An introduction to the Cisco Customer Voice Portal (CVP) installation procedure, including an
explanation of what is and is not within the scope of CVP installation.

•

A list of tasks that need to be completed before installing the Cisco Customer Voice Portal (CVP)
software.

For a complete description of CVP components and features, see the Cisco Customer Voice Portal (CVP)
Product Description.

Introduction to CVP installation
This sections includes descriptions of:
•

What components are included in CVP installation.

•

What components are not included in CVP installation.

What is Included in CVP installation?
Figure 1-1 displays the components involved in CVP installation and configuration procedures:
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Figure 1-1

CVP Installation Components

The Customer Voice Portal (CVP) Release 3.0 Software CD consists of software for each of these
components, with the exception of the Media Server.

Note

The Media Server is shown in Figure 1-1 because—while Media Server installation is not part of the
CVP installation process—copying the System Media Files to the Media Server is part of the process.
You choose the CVP components you want to install using the CVP Installation Wizard’s Select
Components screen, shown in Figure 1-2.

Figure 1-2

Select Components Screen
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Table 1-1 describes what gets installed for each CVP component:
Table 1-1

CVP Installation Components

Option

What is installed

Voice Browser

The Voice Browser, VB Admin tool, default configuration information,
default media file, log viewing executables, and Node Manager.

Application Server

The Application Server, web pages for Application Server
administration, log viewing executables, Node Manager, and files to be
copied to the Gateway.

System Media Files

A sample set of English system media files. (These files are in Mu-Law
8-bit .wav format.)
Note

These files consist of a library of media files/prompts for
individual digits, months (referenced internally by CVP
software for a Play Data script type request), and default error
messages, etc. Creation of a full set of media/prompts for each
locale referenced by the CVP customer is the responsibility
of the customer’s Media Administrator.

Spanish System Media Files A sample set of Latin American Spanish system media files. (These files
are in Mu-Law 8-bit .wav format.)
Note

SDDSN

The Standalone Distributed Diagnostics and Service Network software,
including Node Manager.
Note

Update External SDDSN
Components

Cisco Listener and AlarmTracker software needs to be updated
with support files for SDDSN. This component must be installed
on any machine that runs Listener or AlarmTracker.

Help files describing CVP features and how they interact with
NAM/ICM software.
Note

Voice Browser
Administration

SDDSN needs to be installed on its own machine—it cannot be
co-resident with any other CVP or ICM software product.

Updates to components external to CVP to listen for CVP-based event
messages. These external components are part of the Remote
Monitoring Suite.
Note

CVP Online Help

These files consist of a library of media files/prompts for
individual digits, months (referenced internally by CVP
software for a Play Data script type request), and default error
messages, etc. Creation of a full set of media/prompts for each
locale referenced by the CVP customer is the responsibility
of the customer’s Media Administrator.

In Release 3.0, CVP Online Help is “standalone,” meaning that
you access it through the Programs menu (Start > Programs >
Cisco Customer Voice Portal > CVP Online Help).

The Voice Browser Administration programs that allow remote
administration of the Voice Browser. You do not need to select this if you
have selected Voice Browser, as it is included in Voice Browser.

After initial CVP software installation is complete, there are additional tasks you must perform to:
•

Set up CVP components to communicate with each other and the VoIP components.
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•

Update Cisco Listener and AlarmTracker software to support SDDSN.

These steps are discussed in detail in Chapter 2, “Installing CVP Software.”

What is not Included in CVP Installation?
CVP installation and configuration pertains only to the CVP components and their connections to other
VoIP system components. It does not address initial installation and configuration of VoIP system
components such as:
•

Media Server

•

Gateway

•

Gatekeeper

•

Call Manager

•

CTI Server

•

IPCC

•

NAM/ICM

•

Content Switch

•

ASR/TTS Server

•

Customer Voice Portal VoiceXML Server (optional external VoiceXML application)

Before Installing CVP Software
Before you install the CVP software, you should be aware of all hardware and related software
requirements for CVP. You can view the CVP Bill of Materials at

.http://www.cisco.com/univercd/cc/td/doc/product/icm/ccbubom/index.htm
Note

•

The machine that you are using for the CVP Voice Browser must have only one Ethernet interface
enabled. When installing CVP on a machine with two or more Ethernet interfaces, the additional
interface(s) must be disabled, even if they are not configured. Refer to Windows documentation for
information on enabling/disabling an Ethernet interface.

•

For installation and configuration instructions for these products, see Chapter 2, “Installing CVP
Software” and/or the user manuals for each of the individual products. For information about the
CVP’s interaction with these components in a VoIP system, see the Cisco Customer Voice Portal
(CVP) Configuration and Administration Guide.
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Installing CVP Software
This chapter provides information about the:
•

Procedures for installing and configuring the CVP software.

•

Tasks that need to be performed on non-CVP software components after the CVP software is
installed.

•

Procedures for upgrading CVP components.

•

Procedures for removing CVP components.

•

Troubleshooting.

You must be sure that you have met all of the hardware and software requirements before you begin CVP
installation. Refer to the CVP 3.0 Bill of Materials for more
information.http://www.cisco.com/univercd/cc/td/doc/product/icm/ccbubom/index.htm

CVP Installation and Configuration Procedures
This section walks you through the CVP software installation procedure.

Caution

To prevent sharing violations with other software, close down the following before you begin CVP
installation:
– Programs running Windows 2000 Internet Information Services (IIS) or/and wwwPublishing Services.
– Programs that access directories or files, such as Microsoft Word or Windows Explorer.

Note

Uninstallation of ISN 1.0.1 SDDSN is not supported. If you are installing SDDSN and previously had
SDDSN version 1.0, you need to re-install the operating system on the computer you plan to install
SDDSN version 2.0 on. If you are upgrading the Application Server and Voice Browser to CVP 3.0, and
have SDDSN version 1.0 on the same machine, you need to set SDDSN version 1.0 to “disabled” in the
ICM Services window.
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Note

If Cisco Security Agent (CSA) is running on the machine where you plan to install CVP, you must first
stop the CSA program before installing, upgrading or removing any CVP components. Refer to the
Installing Cisco Security Agent for Cisco Customer Voice Portal, Release 3.0(0) guide for information
about turning off CSA during installation.

How to install Cisco Customer Voice Portal (CVP)
Step 1

From the Install folder on the CVP installation CD, run setup.exe.

Step 2

On the Welcome screen, click Next.

Note

If you click Cancel here or on any of the following dialog screens prior to the “Start Copying Files”
dialog screen, no part of the installation will occur and the Exit Setup dialog box will appear.

Step 3

On the Copyrights screen, click Next.

Step 4

On the License Agreement screen, click Yes. (Use the scroll bar or the Page Up and Page Down keys
to view the entire license agreement.)

Step 5

On the Choose Destination Location screen, specify the drive and directory where the software will be
installed:

Step 6

•

Click Next to accept the default location (C:\Cisco\ISN).

•

Click Browse, select an alternate location, and then click Next.

Note

All CVP components you select will be installed to subfolders under the destination location
with a few exceptions, which are listed in the Application Server and SDDSN sections.

Note

The Cisco Security Agent (CSA) is used on CVP systems. You must use the default directory for
CVP and all third party software, with the exception of the drive letter, which may be changed
for any of the products to work with CSA.

Use the checkboxes on the Select Components screen to choose the CVP components to install on the
local machine and click Next.

Note

SDDSN needs to be installed on its own machine—it cannot be co-resident with any other CVP
or ICM software product.

Note

If you plan to install multiple components on one machine, such as you might in a Lab
environment, you must install all the components you require at the same time. If you do not,
and then later decide to add a component, you will need to uninstall the existing CVP software
and perform a complete re-install.
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The choices are:
•

Voice Browser. Select to install the Voice Browser, VB Admin tool, default configuration
information, default media file, log viewing executables, and Node Manager.

•

Application Server. Select to install the Application Server, web pages for Application Server
administration, log viewing executables, and Node Manager. In addition, Gateway files—which
need to be manually copied to the Gateway—will be placed in a folder named Downloads.

•

System Media Files. Select to install a sample set of US English system media files. (These files
are in Mu-Law 8-bit.wav format.)

•

SDDSN. Select to install the Standalone Distributed Diagnostics and Service Network software,
including Node Manager.

•

Update External SDDSN Components. Select to install updates to components external to CVP
(components of the Remote Monitoring Suite), such as Cisco’s Listener and AlarmTracker, to listen
for CVP based event messages.

•

CVP Online Help. Select to install CVP online help files.

•

Voice Browser Administration. Select to install the Voice Browser Administration programs that
allow remote administration of the Voice Browser. You don’t need to select this if you selected the
Voice Browser component.

•

Spanish System Media Files. This option installs media files that are system prompts when using
the es-mx locale (Latin American Spanish).

Note

The Space Required on <Drive Name> shows a running total of the memory required for the
components selected. Some components, such as the Application Server, have sub-installs that
the running total memory requirements does not take into account.

Step 7

On the Select Program Folder screen, select what Program Folder the CVP program icons should
display under and click Next.

Step 8

On the Node Manager Properties screen, select startup and reboot options.

Note

This screen appears only if you selected to install Voice Browser or Application Server.
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The choices are:
•

Auto start component(s) at system startup. Default: On (“checked”). The default setting enables
auto start of the node-managed Voice Browser upon a reboot.

Note

•

If you are installing an Application Server—with or without the Voice Browser—auto start
will not go into effect until the second reboot of the system. The second reboot is necessary
to accommodate Application Administrator configuration.

No system reboot on error. Default: On (“checked”). The system will not reboot in the event of a
system process failure.

Click Next. The Process Windows Display screen appears. Use the check box on the screen to select
whether or not you want the CVP process windows to display when CVP is running.

Note

Step 9

•

If you choose not to display the process windows with this screen, you can still display them with
limited information at any time by running Start > Programs > Cisco Internet Service Node >
CVP Monitor after CVP is installed. However, by activating the window later with the CVP
Monitor, the processes you can view are very limited (i.e., the heartbeat). If you need to see all of
the processes, you should activate them at this time with this checkbox during install.

•

If unchecked during install, you will need to use dumplog to see the status information, error and
info logging, for the Application Server and Voice Browser. To have your process windows display
all information again, an uninstallation and reinstallation of CVP will be required.

Click Next. One of the following happens:
•

If you did choose to install Application Server, the Choose Destination Location screen appears.
Continue the installation procedure at 10.
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Note

•
Step 10

If you did not choose to install Application Server, the Start Copying Files screen appears.
Continue the installation procedure at 12.

On the Choose Destination Location screen, specify the drive and directory where the Web-based
Application Administrator tool will be installed:
•

Click Next to accept the default location (C:\inetpub\wwwroot\AppAdmin).

•

Click Browse, select an alternate location, and then click Next.

Note

Step 11

Some files have hard coded destinations. For example, the DC Directory associated with the
Application Server is hard coded to C:\dcdsrvr.

This must be configured as the default directory of Microsoft Internet Information
Services (IIS).

On the Username and Password screen, enter your Windows 2000 password, confirm it, and click Next.
You must enter a valid Windows 2000 user account with administrator privileges and password to run
the CVP. By default, the Username field contains the current username and the Password fields are blank.

Note

Step 12

If your Windows 2000 configuration is set up to accommodate a “local Administrator” user and
a “<DOMAIN_NAME>\Administrator” user, enter the “<DOMAIN_NAME>\Administrator”
username and password.

On the Start Copying files screen, click Next. The Setup Status screen tracks installation process and
then the following happens:
•

If you chose to install Application Server, an MS DOS window appears asking permission to stop
IIS Admin Services. Enter Y.

Note

This step is necessary to successfully install the Application Server.

Several more MS DOS windows appear reporting the status of IIS Admin Services install.

Step 13

•

If you chose to install Application Server, during the DC Directory sub-install, a window appears
saying: “This will take between 5 and 30 minutes. Please be patient.” The range in time is due to
differences in system speed, virus scan settings, network traffic, etc. During this time nothing
changes on the computer screen. Please wait for the process to complete.

•

If you chose to install SDDSN, the SDDSN Component Properties screen appears. Continue the
installation procedure at 13.

•

If you did not choose to install SDDSN, the final Cisco CVP Setup screen appears. Continue the
installation procedure at 15.

On the SDDSN Component Properties screen, specify how the CVP will convey events to SDDSN.
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Do the following:
•

To enable the ICM software to send diagnostic messages directly to the Cisco TAC:
– Select the Phone Home checkbox and click Configure. The Phone Home Configuration

screen appears.
– Specify a Phone Home setting and click OK. The SDDSN Component Properties screen

reappears.

Note

•

To enable the optional Cisco Works 2000 feed, select the Enabled checkbox and enter the name of
a CiscoWorks server in the Server Name field.

Note

•

For detailed information about Phone Home Configuration settings, see the Cisco ICM
Software Installation Guide.

Cisco Discovery Protocol (CDP) is required for Cisco Works 2000. CDP is automatically
installed during ICM software setup. However, if CDP is disabled, CiscoWorks 2000 will
not run.

To enable the optional SNMP Feed:
– Select the Enabled checkbox and click Configure. The SNMP Feed Configuration screen

appears.
– Use the checkboxes to specify the SNMP Configuration information and click OK.

Note

The SNMP feed must be configured to use the legacy SNMP agent. Be sure to check the
“Use legacy SNMP Agent” checkbox in the SNMP Configuration dialog.
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The SDDSN Component Properties screen reappears.

Step 14

You may need to install the SNMP Windows 2000 component.

Note

For information on the SNMP event feed, see the Cisco ICM Software Administrator Guide.

Click Next. The SDDSN Setup: SDDSN Server Check Setup screen appears.

Note
Step 15

Note

Some files have hard coded destinations. For example, for SDDSN, C:\ICR\bin is hard coded.

Click Next. SDDSN installs and the final Cisco CVP Setup screen appears. Do the following:
•

If applicable, select the “Restart my computer” option.

Note

•

These options only appear on the CVP Setup Complete screen if you are installing a
component that requires reboot. Cisco recommends that you select the “Yes” option.

Click Finish. One of the following happens:
– If you did not choose to install the Application Server, setup is complete and the CVP

Installation Wizard closes.
– If you chose to install the Application Server, a “Setup not complete” screen displays. See the

“Application Server Configuration” for further instructions.
– If you chose to install the Application Server and you chose the “Restart my computer” option,

the machine reboots. After reboot, login; an MS-DOS window appears showing the status of the
DC Directory Schema update. Check the information in this window carefully for error
messages!

Note

If errors do appear in the MS-DOS window, press a key to complete the setup process,
and then turn to the “Troubleshooting CVP Install / Upgrade / Uninstall” section on
page 2-24.

When the prompt “Press any key to continue…” appears, press a key. Several pop-up windows
appear and the Application Server Configuration box disappears to indicate installation
completion.

During the Application Server installation, there is a new message window that says “This will take
between 5 and 30 minutes. Please be patient.” This is informing the user that depending on their system
speed, virus scan settings, network traffic, etc., the DC Directory sub-install will take a while. Do not
worry that nothing is changing on the screen. After you install the CVP software, you must configure
the Application Server and Voice Browser.
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Caution

If you chose the “Restart my computer” option be very careful logging in! If the information is not
exactly the same as you entered in Step 11 on page 5, the Application Server will not configure properly.
Also, it is highly recommended that your system be connected to a physical LAN, rather than a wireless
LAN.

Application Server Configuration
This section contains the minimum steps required to configure the Application Server (AS) after initial
CVP installation.

Note

For more information about Application Server administration, see the Customer Voice Portal (CVP)
Configuration and Administration Guide.

How to configure the Application Server
On the machine where you install the CVP software:
Step 1

Select Start > Programs > Cisco Internet Service Node> Application Server > Application
Administrator. The Enter Network Password dialog box appears.

Step 2

Login as the Windows 2000 Administrator.

Caution

Again, be very careful logging in! If the information is not exactly the same as you entered in Step 11
on page 5, the Application Server will not configure properly.
The Application Administration Main Menu appears.
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Step 3

Click Call Definition. The Call Definition page appears.

Step 4

Click one of the Group Number links:
•

Group Number 100 / New Call (the first row in the table) if you want to define call parameters for
post-routing calls.

•

Group Number 200 / ID from ICM software (the second row in the table) if you want to define call
parameters for translation routing.

The Port Group Configuration (ID from ICM software / New Call) page appears.

Note

For information about setting the Dialed Number Maximum Length if noCorrelation ID is Present
and Maximum Number of Calls Allowed fields, see the Cisco Customer Voice Portal (CVP)
Configuration and Administration Guide.
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Step 5

Use the Initial Port and Last Port fields to specify a range of virtual ports for the Group Number.

Caution

The Application Server will not start up if you do not define any ports. Also, the number of
ports you define determines the number of calls that can be processed simultaneously. Setting
a large number of ports will impact system performance, even if the number of actual calls is
not large.

Step 6

Click Update. The changes take effect immediately.

Step 7

Click Return to Main Menu.
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Step 8

Optionally, do the following:
•

Note
•

Note

•

Click ICM. The ICM Subsystem Configuration page appears

This step is only necessary if you need to change the default VRU port setting.
Specify a VRU Connection Port value. This is the TCP/IP socket number the Application Server will
use to receive messages from the Cisco ICM’s PG (PIM). (Default: 5000.)

The VRU port setting needs to match the ICM software PG (PIM) setting. For more information
on setting up the ICM software PG, see the Cisco ICM Software Configuration Manager
documentation.
Click Update, then Return to Main Menu.

Step 9

Click Engine. The Engine Status page appears.

Step 10

If you will be using an external VXML application, click Engine Configuration. Check the Allow
External VXML checkbox.

Step 11

Click Log Configuration. The Log Configuration page appears.

Step 12

Use the SDDSN section to specify settings to be used by the Alarm Forwarder process:

Step 13

•

SDDSN Node 1. (Default: <none>.) The host name or IP address of the first SDDSN instance.

•

SDDSN Node 2. (Default: <none>.) The host name or IP address of the second SDDSN instance.

•

SDDSN Port 1. (Default: 40080.) The listening port number for the first SDDSN instance.

•

SDDSN Port 2. (Default: 40080.) The listening port number for the second SDDSN instance.

•

SDDSN Ascending Retries. (Default: 5.) The upper limit of geometric growth for the time between
retries when both SDDSN instances are having problems.

Scroll down until you see the Update button and click it. Changes to SDDSN link configuration take
effect immediately.
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Step 14

Step 15

Click Status. The Engine Status page appears. Do the following:
•

To enable the auto-refresh feature on this page, click the checkbox and specify how often the page
should refresh.

•

Click Start, then click Yes in the confirmation message box that appears.The Application Server
status changes to RUNNING and a green light appears, indicating that all subsystems are running
and the Application Server is ready to accept calls.

When finished using the Application Administration tool, select File > Close. The Application
Administrator window closes, however, the Application Server remains running under ICM Service
Control.

Voice Browser Configuration
This section contains the minimum steps required to configure the Voice Browser (VB) after initial CVP
installation.

Note

In order for the VB Admin tool to function, the Voice Browser must be running.

Note

For more information about Voice Browser administration, see the Customer Voice Portal (CVP)
Configuration and Administration Guide.
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How to configure the Voice Browser
Step 1

Select Start > Programs > Cisco Internet Service Node >Voice Browser > VB Admin. A window
containing a command line prompt (>>>>) appears.

Step 2

Enter setASList <NewValue>, where <NewValue> is the base URL of Application Servers for the Voice
Browser).
The syntax for the base URL is: <AppServer>:8000/servlet/isn, where:
•

<AppServer> is the hostname or IP address of the machine that is running the Application Server.
(Default: localhost.)

•

:8000/servlet/isn is a fixed string that you must append to each name in the AppServerList. (The
string must begin with a colon [:].)

Examples:
setASList localhost:8000/servlet/isn
setASList “machine1:8000/servlet/isn machine2:8000/servlet/isn”

Note

Step 3

If you want a call restarted from the beginning if there is a NAM/ICM or Application Server problem
during the course of the call, enter SetNewCallOnly on.

Note

Step 4

Note

Step 6

Do not set this value to “on” if you expect any pre-routed calls to come to this Voice Browser.
The CVP cannot restart pre-routed calls.

If IP transfers will be part of your call configuration, enter the following:
•

Step 5

The command setASList contains no spaces. However, the use of double quotes is required
when defining multiple Application Servers.

setGateKeeper<NewValue>, where <NewValue> is the IP address for the Gatekeeper serving the
Voice Browser.

You must shut down and restart the Voice Browser for this setting to take effect.

If you chose to install SDDSN, and need to change the default settings, enter the following:
•

setSDDSN1 <NewValue> (where <NewValue> is the host name or IP address of the first SDDSN
instance. (Default: <none>)

•

setSDDSN2 <name> (where <NewValue> is the host name or IP address of the second SDDSN
instance. (Default: <none>)

Note

If there is only one SDDSN in service, SDDSN2Node should be set to the same node as
SDDSN1Node.

Enter q to exit VB Admin.
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Installing the CVP VoiceXML Server Software
If you have purchased the optional Cisco CVP Voice Server software, you can find instructions for
installing the software in the Cisco Customer Voice Portal VoiceXML Server Getting Started Guide.

Note

Un-install instructions are also available in the Cisco Customer Voice Portal VoiceXML Server Getting
Started Guide.

After you Install CVP Software
After you install the CVP software and configure the Application Server and Voice Browser, there are
tasks you need to perform on some non-CVP Cisco software components before you can use CVP
features in your call center. These include:
•

Setting up Cisco Gateways/Gatekeepers to interact with CVP

•

Updating Cisco Listener and AlarmTracker software to support SDDSN.

•

Setting up Cisco NAM/ICM software to interact with CVP.

The sections that follow provide more information.

Setting up Gateways/Gatekeepers to Interact with CVP
You must configure Gateway(s) and Gatekeeper(s) in order to properly route inbound calls (calls
originating from the caller into CVP) and outbound calls (calls being transferred to an agent through
CVP).
Depending on the CVP configuration being used, certain folders of files need to be copied from the CVP
Application Server machine to the Gateway(s). Use Table 2-1 to determine which folder you need to
copy for your system.The first three columns of the table define a possible combination of features in a
CVP configuration:
•

Voice Browser. Your CVP configuration would include a CVP Voice Browser when the CVP needs
to queue calls or provide call transfer after an agent has answered the call.

•

CSS. If your CVP configuration includes one or more Cisco Content Services Switches to provide
enhanced failover and load-balancing capabilities between the Voice Gateways and the ASR/TTS
Servers, HTTP Media Servers, and the CVP Application Servers.

Note

•

When a CSS exists in the configuration, it must be used with all the Servers in the
configuration.

Call Restart. Your CVP configuration would include the Call Restart feature to restart a call in the
event of a CVP Application Server failure in mid-call. The restarted call will appear to the ICM
software as just another new call.
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Note

The Call Restart feature can only be used when the CVP is a Type 5 or Type 6 Network VRU
or when the CVP is the main routing client for the call. In configurations where a call is
pre-routed by a NIC to a CVP (that is, the CVP is a VRU Type 2, 3, 7 or 8), the restart feature
cannot be used.

Once you have determined the feature combination of your CVP configuration, open the folder and copy
all files specified in the fourth column of Table 2-1 from the CVP Application Server machine to flash
memory on the Gateway(s).

Note

Table 2-1

For complete instructions for copying files to the Gateways, see the copy CLI command in the
documentation for the Gateway that you are using in your configuration.

Application Server Files to Copy to the Gateway/Gatekeeper

CVP Feature Combinations
Voice Browser?

CSS ?

Call Restart?

Folder To Copy

Yes

Yes

Yes

<basedir>/ApplicationServer/Downloads/VB-CSS-CallRestart

Yes

Yes

No

<basedir>/ApplicationServer/Downloads/VB-CSS-noCallRestart

Yes

No

Yes

<basedir>/ApplicationServer/Downloads/VB-noCSS-CallRestart

Yes

No

No

<basedir>/ApplicationServer/Downloads/VB-noCSS-noCallRestart

No

Yes

Yes

<basedir>/ApplicationServer/Downloads/noVB-CSS-CallRestart

No

Yes

No

<basedir>/ApplicationServer/Downloads/noVB-CSS-noCallRestart

No

No

Yes

<basedir>/ApplicationServer/Downloads/noVB-noCSS-CallRestart

No

No

No

<basedir>/ApplicationServer/Downloads/noVB-noCSS-noCallRestart

Note

If your CVP configuration includes a CSS, you also need to copy the askeepalive.txt file from the root of the
Downloads directory to the Scripts directory of the CSS switch.

Caution

Note

When copying the files, do not rename the destination files on the Gateway.

Gateway configuration is case sensitive. Therefore, the file names of any files that you downloaded and
are referenced in the gateway configuration must match exactly.

A further note on copying files to the Gateway/Gatekeeper
After you enter a copy command, the Gateway/Gatekeeper’s IOS software will prompt you to confirm:
•

The destination file name; in response, press Enter.

•

That you want it to erase all files in the flash memory; in response, type n and press Enter.

The IOS dialog does not reflect that n was typed, or respond for several seconds. This is normal behavior;
IOS copies files to the flash memory without overwriting and eventually indicates that the file has been
loaded. Example 2-1shows a sample Gateway IOS dialog:
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Example 2-1

Gateway copy boostrap.vxml command

gateway#copy ftp://10.1.1.10/isn30files/bootstrap.vxml flash:
Destination filename [bootstrap.vxml]?
Accessing ftp://10.1.1.10/isn30files/bootstrap.vxml...
Erase flash: before copying? [confirm]
Loading isn30files/bootstrap.vxml !
[OK - 2895/4096 bytes]

*/ Press <Enter>
*/ Type n and press <Enter>

Verifying checksum... OK (0x8FD9)
2895 bytes copied in 6.564 secs (441 bytes/sec)"

Note

FTP service needs to be installed and running under IIS on the Application Server to be accessed for file
downloads. The Gateway/Gatekeeper returns an “undefined error” when attempting to connect to an
Application Server without the FTP installed.

Updating Cisco NAM/ICM Components to Support SDDSN
Cisco Listener and AlarmTracker software (part of the Remote Monitoring Suite) needs to be updated
with support files for SDDSN. You do this by installing the CVP component called “Update External
SDDSN Components” on any machine that runs Listener or AlarmTracker.

How to update external SDDSN components
Step 1

From the installation CD, run SETUP.EXE.

Step 2

On the Welcome screen, click Next.

Step 3

On the Copyrights screen, click Next.

Step 4

On the CVP License Agreement screen, click Yes.

Step 5

On the Choose Destination Location screen, specify the drive and directory where the software will be
installed:
•

Click Next to accept the default location (C:\Cisco\ISN).

•

Click Browse, select an alternate location, and then click Next.

Note
Step 6

All CVP components you select will be installed to subfolders under the destination location.

On the Install Cisco CVP Components screen, select the Update External SDDSN Components
option (this should be the only option you select on this screen) to install updates to components external
to CVP, such as Cisco’s Listener and AlarmTracker. These updates make it possible for the components
to process CVP-based event messages.
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Step 7

Click Next.

Step 8

On the Start Copying files screen, click Next.

Step 9

On the CVP Setup Complete screen and click Finish.

Setting up Cisco NAM/ICM Software to Interact with CVP
There are several “one time only” steps you need to take to enable interaction between NAM/ICM and
CVP software:

Note

•

Determine what CVP Network VRU types you need to define

•

Define a CVP Network VRU

•

Set the Enable Expanded Call Context option

•

Define expanded call context (ECC) variables for CVP

•

Define the default Network VRU

•

Configure the Peripheral Gateway (PG) for the CVP

For more information, see the “CVP Deployment Options” appendix in the Cisco Customer Voice Portal
(CVP) Configuration and Administration Guide.

Upgrading CVP Software
This section walks you though the CVP software upgrade procedure.
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Caution

To prevent sharing violations with other software, close down the following before you begin CVP
installation:
– Programs running Windows 2000 Internet Information Services (IIS) or/and wwwPublishing Services.
– Programs that accesses directories or files, such as MS Word or Windows Explorer.
– If performing an upgrade on a live system, all calls must be ended gracefully before starting the
upgrade process.

How to upgrade Cisco Customer Voice Portal (CVP)
Only components currently installed on the system will be upgraded. During the Upgrade procedure, a
message box appears confirming what components are available.

Note

If you click Cancel on any of the dialog screens prior to the Start Copying files screen, no part of the
installation will occur and the Exit Setup dialog box will appear.

Step 1

Close all open applications.

Step 2

From the Upgrade folder on the CVP installation CD, run setup.exe.

Step 3

On the Welcome screen, click Next.

Note

If the system determines that the CVP upgrade version is older than the version currently installed or an
unsupported upgrade is attempted, an informational message appears and the system exits Setup without
performing the upgrade.

Note

Setup also checks for a valid version of MS JVM and for Windows 2000 on the machine. If these
programs are not detected, the system exits Setup without performing the upgrade. You must install these
programs before you can proceed.

Step 4

On the Copyrights screen, click Next.

Step 5

On the License Agreement screen, click Yes. (Use the scroll bar or the Page Up and Page Down keys
to view the entire license agreement.)

Step 6

Click Next. The Process Windows Display screen appears. Use the check box on the screen to select
whether or not you want the CVP process windows to display when CVP is running.

Note

If you choose not to display the process windows with this screen, you can still display them at any time
by running Start > Programs > Cisco Internet Service Node > CVP Monitor after CVP is installed.
However, by activating the window later with the CVP Monitor, the processes you can view are very
limited (i.e., the heartbeat). If you need to see all of the processes, you should activate them at this time.

Step 7

Click Next. The Spanish System Media file window displays. Select the checkbox if you want to install
the media files
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Note
Step 8

Note

Step 9

This window displays only if you are upgrading from the ISN version 2.0.
On the Start Copying files screen, click Next.

Since this is an upgrade procedure, you will not be able to set a destination location; The location where
the components were initially installed is where the upgrade will take place.
Click Yes in response to all the confirmation message boxes that appear regarding the list of CVP
components to be upgraded, services to be stopped, read-only files to be replaced, etc.

Note

Step 10

If an MS-DOS window appears requesting permission to stop IIS Admin Services, enter Y.

Note
Step 11

If services are running at the time of upgrade, MS-DOS windows will appear reporting the status
of their shutdown.

This action will actually stop Simple Mail Transport Protocol, as it is a dependant service of IIS.

If a window appears asking if you want the upgrade to start the Application Server or Voice Browser
upon reboot, click Yes.

Note

MS-DOS windows appear reporting the status of the service start-ups.

Step 12

Click Finish.

Step 13

Reboot the computer.

Note

Warning

•

If you run the install after you have already performed an upgrade, the uninstall program will run
and query you with the message “Do you want to completely remove the selected application and
all of it’s components?” Unless it is your intention to uninstall CVP, you should select Cancel,
otherwise CVP will be uninstalled and will not function.

•

To install subsequent patches to the CVP software and the optional Voice XML Server the machine
you are installing the patch to will require access to the Internet.

After completing an upgrade on a standalone application server for comprehensive deployments, you
must then tftp the newly updated files from the download directory to the gateway. Please see
instructions based on the section , “After you Install CVP Software” to determine the appropriate
application files based on your deployment.
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Uninstalling CVP Components
This section describes the procedure for removing CVP components.

Caution

To prevent sharing violations with other software, close down the following before you begin CVP
uninstallation:
– Programs running Windows 2000 Internet Information Services (IIS) or/and wwwPublishing Services.
– Programs that accesses directories or files, such as MS Word or Windows Explorer.

How to remove CVP software
Step 1

Close all open applications.

Step 2

Select Start > Settings > Control Panel > Add/Remove Programs.

Step 3

Select the Cisco Internet Service Node (ISN) entry and click Change/Remove.

Caution

It is very important to choose the Cisco Customer Voice Portal (CVP) entry to ensure a clean uninstall.
Selecting this entry removes all other CVP components in the Installed Program list, except upgrades or
hotfixes. For more information, see “How to remove CVP software after an upgrade to a higher version
number” section on page 2-21.

Step 4

In the Welcome to the Cisco CVP Setup Maintenance Setup dialog box, select Remove and click Next.

Step 5

In the Confirm File Deletion dialog box, click OK.

Step 6

If a DOS pop-up box appears asking permission to stop IIS Admin Services, enter Y.

Step 7

Continue clicking Yes in all other confirmation boxes, as appropriate.

Caution

A pop-up box will appear for all Shared or Read-Only files. If other ICM software products are sharing
files, you must be extremely careful not to remove the files. Possible shared files include:
<Targetdir>\bin\cat2.dll
<Targetdir>\bin\msgs2.dll
<Targetdir>\bin\MESS2.HLP
<Targetdir>\Filters\appl2.flt
<Targetdir>\Filters\custvis2.flt
<Targetdir>\Filters\object2.flt
<Targetdir>\Filters\primpos2.flt
The Cisco CVP Maintenance Complete dialog box appears.

Step 8

Click Finish.
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Step 9

Do one of the following:
•

If the “Restart my computer” prompt appears, select Yes.

•

If the “Restart my computer” prompt does not appear:
– Close the Add/Remove Programs dialog box.
– Reboot the machine manually.

How to remove CVP software after an upgrade to a higher version number

Caution

Step 1

The order in which you remove the CVP software is very important: you must remove the software in
reverse order to how it was installed. In other words, if you installed the CVP software first, HotFix1
software second, and Upgrade software third, you need to remove the Upgrade first, HotFix1 second,
and CVP third.
Stop CVP services so calls will not be processed through the machine as you remove files.
•

To bring the Voice Browser out of service, in VB Admin, enter setservicemode out.

•

To bring the Application Server out of service, on the Engine page in Application Administration,
click Go Out Of Service.

Step 2

Verify that all the calls have completed before continuing with the uninstall.

Step 3

Stop all Windows programs.

Step 4

Select Start > Settings > Control Panel > Add/Remove Programs.

Step 5

Select the most recent install—either a hotfix (ISNHFx, where x is the hotfix number) or an upgrade
(ISNUpgradex.y.z where x.y.z is the version number) and click Change/Remove.

Step 6

In the Welcome to the Cisco CVP Setup Maintenance Setup dialog box, select Remove and click Next.

Step 7

In the Confirm File Deletion dialog box, click OK.

Step 8

Click OK in response to all the confirmation message boxes.

Step 9

If a DOS pop-up box appears asking permission to stop IIS Admin Services, enter Y.

Step 10

Continue clicking Yes in all other confirmation boxes, as appropriate.

Step 11

If any read-only files are detected, select the “Don’t display this message again” checkbox and click Yes.

Step 12

Click Finish in the Maintenance Complete dialog box.

Note

Step 13

Note

At this point, your CVP system is incomplete. Many required files are no longer available. You
can either continue to uninstall the rest of CVP, or—if you uninstalled an upgrade—run the same
or another CVP upgrade again to reinstall the files that have been removed.

Reboot the computer.

If you are uninstalling multiple hotfixes, you may uninstall all of them at once without rebooting the
machine. However, it still recommended that you reboot after a CVP upgrade or install.
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Step 14

Repeat the procedure described in Step 5 through Step 13 to uninstall any other obsolete CVP hotfixes
and upgrades—in reverse order of installation.

Step 15

Remove the CVP software. From Start > Settings > Control Panel > Add/Remove Programs, select
Cisco Customer Voice Portal (CVP) and click Change/Remove. Follow the procedure described in Step
5 through Step 13.

CVP Security
CVP provides for enhanced security and includes the following new security features:
•

The CVP application administration login/password not based on the System admin login/password.

•

A hierarchical permissions structure for CVP maintenance:
– CVP Super-users can start/stop CVP processes and perform CVP configuration.
– CVP Privileged users can view configurations
– CVP Read-only users can view log files and check operational status

•

Voice Browser configuration that must be password-protected.

•

Passwords strongly formatted and changeable without re-installation of software.

•

View of the entire VB configuration in a single text format.

These features are implemented by a script that is run automatically after you install the feature. This
script creates three Windows user groups (cvpadmin, cvpconfig, and cvpuser) and adjusts folder/process
permissions accordingly.

Note

The system administrator must still perform CVP installations, which includes Service Releases (SR)
and Engineering Specials (ES).

Note

Internet Service Node > CVP Monitor after CVP is installed. However, by activating the window later
with the CVP Monitor, the processes you can view are very limited (i.e., the heartbeat). If you need to
see all of the processes, you should activate them at this time

Activating the Security Feature
After you have installed the feature, you can active it, as follows.
Step 1

Install the 'subinacl' utility from the Windows Resource kit. You can obtained this online from
http://www.microsoft.com/downloads. Search for 'subinacl'

Step 2

Place the subinacl utility on the C: drive and accept all defaults during installation.

Step 3

From the Windows Start menu, select Start > Programs > Administrative Tools > Internet Services
Manager. Click on machine name

Step 4

Click on the Default Web Site

Step 5

Right click on AppAdmin and select Properties
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Step 6

Click on the Directory Security tab.

Step 7

Click Edit in the Anonymous access and authentication control section.

Step 8

Uncheck Basic Authentication and check Integrated Windows Authentication. Click OK and click
OK again on the AppAdmin Properties screen.

Step 9

Open a DOS command window and type ISNSecurity. This runs a batch script that creates the three
Windows user groups (isnadmin, isnconfig and isnuser) and adjusts all folder and registry permissions
accordingly.

Step 10

There is a manual step during the script. Follow the instructions provided and press Enter to complete
execution of the script.

Note

The script may be re-run multiple times in the event a mistake is made or an error occurs.

Step 11

To add users to a group, from the Window Start menu, select Start > Settings > Control Panel >
Administrative Tools > Computer Management > Local Users and Groups

Step 12

Turn off remote procmon access to the CVP machine. From VBAdmin, 'SetSecurityMask 0' and then
restart the CVP VB. This prevents unauthorized remote access to procmon.

Note

Step 13

Once you perform this step, all CVP maintenance must be performed on the CVP box itself via
PCAnywhere, Terminal services, etc.

Display view-only ISN process windows (optional step). During install, if the selection was made to hide
the CVP process windows you may want to display “view-only” CVP process windows to the user (i.e.
if these windows are terminated, they do not terminate the actual CVP processes). To bring up view-only
process windows, select: Start > Programs > Cisco Internet Service Node > CVP Monitor

Current Limitations of the CVP Security Feature
The following limitations pertain to the CVP Security Feature:
•

The System Administrator must perform installs (including Service Releases and Engineering
Specials).

•

The CVP process windows must be hidden from view because an existing Microsoft defect currently
allows non-privileged users to close them. Although it was supposedly fixed in Windows 2000
Server SP4, testing has shown that the defect still occasionally appears. (see Windows Knowledge
base article 816131) http://support.microsoft.com/default.aspx?scid=kb%3BEN-US%3B81613.
You can monitor system status by:
– looking at system status in ICM service control
– running CVP Monitor to activate view-only CVP process windows
– examining CVP logs

•

Remote procmon administration for the ISN Voice Browser is disabled because procmon cannot
easily perform login/password procmon security checks. CVP voice browser administration must be
performed on the machine itself.

•

Logging on to any CVP server (i.e., application server, voice browser) with a remote connection or
to Windows Terminal Services as a read-only user (isnuser) is not supported. Note that any session
associated with that type of log on attempt must be reset using the Terminal Services Manager..
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Troubleshooting CVP Install / Upgrade / Uninstall
Table 2-2 describes how to resolve problems you may encounter while:

Table 2-2

Symptom

•

Installing CVP software and performing the initial configuration.

•

Upgrading CVP software.

•

Uninstalling CVP software.

Troubleshooting

Possible Cause and Solution

Possible Cause:
When installing or
uninstalling the CVP
Application Server software,
an SNMP.exe application
error message appears.
Possible Solution:

The SNMP service is being used by a third-party program (such as the
HP Net Server Agents program) or a previously-installed version of the
CVP Application Server.
A step in the CVP installation and uninstallation process is to stop the
SNMP service; if the service is in use, an error is generated.
Click OK in the error message pop-up to stop the SNMP service in order
to successfully install or uninstall the Application Server. Upon reboot,
SNMP will start up automatically.
Note

This action causes a temporary SNMP service interruption.

During CVP installation, the Possible Cause:
following error message
appears: “The InstallShield
Engine(iKernel.exe) could
not be installed. Ikernel.exe Possible Solution:
could not be copied to
C:\Program Files\Common
Files\InstallShield\Engine\6
\Intel 32.”

Multiple instances of the Install Program are being run.

Possible Cause:
When accessing the
Application Administrator
page, one of the following
error messages appears: “You
are not authorized to view
this page” or a “Permissions
Denied.”

You are logged into the Application Administrator Page as the “wrong”
administrator.

Note

InstallShield (the install program for the CVP) allows only one
ikernel.exe to be running at a time.

Stop all install programs and run the CVP installation program.

On Windows 2000, it is common for there to be two Administrator users
defined:
•

A local Administrator user.

•

A <DOMAIN_NAME>\Administrator user.

These Administrators can have different passwords and privileges.
Possible Solution:

Either administrator can be the “right” one as long as that user is a
member of the local Administrators group and has the proper file
permissions.
Note

Adding the user to the Administrators group will probably fix
file permissions, too.
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Table 2-2

Troubleshooting (continued)

Symptom

Possible Cause and Solution

Possible Cause:
During installation, a
“Provider unavailable
exception” error appears
after the Application Server
has been installed and
immediately after the reboot.
(This might also happen if
there is a change in Network
Service.)
Possible Solution:
Also, you might see the
following error appear during
installation or when you try
to access Application
Administration:
Possible Cause:
“com.cisco.wfframework.
repository.ProviderUnavailableException: (80004005)”

Possible Solution:

The DC Directory Service
will not start.

The Application Server machine is not connected to the VoIP LAN. This
machine must be connected to the network prior to installation.
To verify that the Application Server is not connected to the VoIP LAN,
try pinging another machine that this Application Server should
communicate with, such as the ICM software. Do the following:
1.

From a command line window, enter:
ping <ip address of the other machine>

Connect the Application Server to the LAN. If this problem occurred
during installation, you may be required to uninstall the CVP (using
add/remove programs) and reinstall the Application Server (along with
any other components that you want).
The DC Directory Service might not be running.
To verify this, do the following:
1.

Select Start > Program Files > Cisco Internet Service Node >
Service Control.

2.

Select the All checkbox on the dialog box. All Windows 2000
services installed on the machine display.

3.

Verify that the DC Directory Service is running.

Do the following:
1.

If the DC Directory Server service exists but its State is not
RUNNING, click Start.

2.

If the DC Directory Server service does not exist, then the
Application Server was either not installed properly or a portion or
CVP program was removed. Uninstall the Internet Service Node
using Add/Remove programs and reinstall CVP. Please refer to the
Uninstalling CVP Components section of this guide.

Possible Cause:

If you change the password of the Windows user account that was
specified in the CVP installation, you also need to change the password
for the DC Directory.

Possible Solution:

Do the following:
1.

From Windows Services, double-click DC Directory Server.

2.

Select the Log On Properties tab.

3.

Specify the name and password to use when starting the DC
Directory Service.

4.

Click OK.
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Table 2-2

Troubleshooting (continued)

Symptom

Possible Cause and Solution

Possible Cause:
After installation, as you
open the Application Server,
the following error message
Possible Solution:
appears in Application
Server logs: “javax.naming.
CommunicationException:
nabu11:8404 [Root Exception is java.net.Connect
Exception:Connection
Refused]”
During Application Server
configuration setup or on
Application Server startup
the following error message
appears: “javax.naming.
CommunicationException:
computer_name:8404 [Root
Exception is java.net.
ConnectException:ConnectionRefused]” error message.

Uninstall the CVP and try the installation again.

Possible Cause:

DC Directory is running on an account other than LocalSystem.

Possible Solution:

Reinstall the CVP using the proper Windows 2000 administrator
account. (For more information, see the CVP Installation and
Configuration section at the beginning of this chapter.)

Possible Cause:

Files are missing under c:\dcdsrvr due to an incomplete install or
uninstall.

Possible Solution:

Reinstall the CVP using the proper Windows 2000 administrator
account. If necessary, contact the Cisco Technical Assistance Center to
clean up the machine before reinstalling CVP.

Possible Cause:
While trying to uninstall
CVP, a dialog box appears
saying that a file is in use and
the software cannot be
uninstalled.
Possible Solution:

An “Inspect” error occurs
during SDDSN installation.

The DC Directory Service was not installed properly.

Voice Browser, Alarm Forwarder, SDDSN, and dumplog use the files
msgs2.dll, Icrmsgs.dll, cat2.dll, Icrcat.dll, and sometimes, the filter files
appl2.flt, custvis2.flt, object2.flt, and primpos2.flt. If you try to
uninstall VB, AS, or SDDSN while one of the other processes is using
these files, the Uninstall procedure will not be able to remove them.
Before running Uninstall, make sure that:
•

All CVP services are stopped (this eliminates Voice Browser and
Alarm Forwarder as possible sources).

•

Close ICM Service Control

•

dumplog is not running.

•

If you are uninstalling CVP from an SDDSN machine, the SDDSN
services are stopped.

•

You close all file accessing programs (such as Microsoft Word or
Windows Explorer).

Possible Cause:

The SDDSN installation failed.

Possible Solution:

Do the following:
1.

Reboot the system.

2.

Uninstall the CVP software.

3.

Reboot the system.

4.

Install the CVP software with SDDSN again.

5.

Reboot the system.

Note

If the CVP software still did not install correctly, contact Cisco
Customer Support.
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Table 2-2

Troubleshooting (continued)

Symptom

Possible Cause and Solution

After an Application Server Possible Cause:
install and reboot, you see the
following error:

The previous Application Server was uninstalled, and then the computer
was not rebooted before the next AS install.

“There was an error. Error
Description: ActiveX
component can't create
object.”

You must reboot the computer after each AS install and uninstall.

Possible Solution:

If you attempt to install CVP Possible Cause:
without Microsoft Java
Virtual Machine (MS JVM),
you see the following error: Possible Solution

Version of the MS 2000 operating system that was installed did not
contain MS JVM
Install Microsoft Windows 2000 Server with Service Pack 4
Note

Microsoft provides as an option the Integrated Service pack that

simultaneously installs the operating system and SP4. Cisco
does not support the Integrated Service Pack method. Apply SP4
only after Windows 2000 Server has been installed.
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